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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Agenda 

• Úvod  

• NI ELVIS II  a NI MyDAQ 

• Multisim 

• Propojení s LabVIEW 
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Traditionally… 

Textbooks Simulation Hardware 

Comparing simulated data 

with measurements 

Classroom Laboratory 
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PC-Based Electronic Circuit design 

http://www.ni.com/academic/circuits.htm 

“We have never really, as educators, gotten these three elements [of theory, 

simulation, and experimentation] to work together well. The weakest has been 

the laboratory. With the advances in simulation with [NI] Multisim and the 

advances in experimentation with [NI] myDAQ, we'll be able to bring all of 

these elements together in a more exciting way.”  

 

 - Adel Sedra, Dean and Professor of Engineering at University of Waterloo 
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National Instruments 

Non-GAAP Revenue: $1.04B revenue in 
2011, $280M revenue in Q4 2011 

Global Operations: Approximately 6,200 
employees; operations in more than 40 
countries  

Broad customer base: More than 35,000 
companies served annually  

Diversity: No industry >15% of revenue 

Culture: Ranked among top 25 companies 
to work for worldwide by FORTUNE 
Magazine and the Great Places to Work 
Institute 

Strong Cash Position: Cash and short-term 
investments of $366M at December 31, 
2011 
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Long-term track record of growth and 
profitability 

Offering graphical system design solutions for Test and Measurement and 

Industrial Embedded 
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What is Virtual Instrumentation? 
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NI Electronics Education Platform 

Electronics Education Platform 
 

National Instruments tools address challenges of circuit 
education 

13. 4. 2012 

8 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Necessary Equipment 
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ELVIS HW 
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Agenda 

• ELVIS – Electronic Laboratory for Virtual 

Instrumentation 

• ELVIS addons 

• MyDAQ 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Introduction | From concept to reality 

• LabVIEW / DAQ based system 

• Removable prototyping board 

• Integrated instrument capability 

Earlier  2003 2004 2005 2006 2007 2008 2009 

NI ELVIS workstation 

Personal Computer System 

External DAQ Device 

Software 

NI ELVIS II NI ELVIS II+ 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

What is NI ELVIS? | At the core…12 
Instruments 

Data Acquisition  

& Generation Oscilloscope 

Circuit Protection 

DMM 
Power  

Supply 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

NI ELVIS II | Hardware Specifications 

Digital Multimeter 
 Isolated measurements 
 5½ digit resolution 
 60 VDC, 20Vrms,  2 ADC, 2 Arms, 

100MΩ 

 

Internal Circuit 
Protection 
 Resettable fuses 

Function Generator 
 10 bit,  ±5V range 
 0.2 Hz to 5 MHz Sine 
 0.2 Hz to 1 MHz 

Triangle/Square 
 Software or manual 

control 
 BNC or prototyping 

board connection 

USB Connectivity 
 Plug-and-play capability 
 USB 2.0 Connection 

Oscilloscope 
 16-bit resolution 
 1.25 MS/s single channel, 

500kS/s two channel aggregate 
 1 to 1.5 MHz Bandwidth 
 1x and 10x probe 
 ±10 V input range 
 AC/DC coupling 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

NI ELVIS II | Hardware Specifications 

Impedance Analyzer 
 0.2 Hz to 35 kHz Range 
 NPN, PNP, Diode 

Other Analyzers: 
 Bode Analyzer 
 2-wire Current Voltage 

Analyzer 
 3-Wire Current Voltage 

Analyzer 

 

Variable Power  Supply 
 10-bit resolution 
 0 to +12V, 0 to -12V 
 500 mA current range 

Integrated DAQ 
 AI sampling rate 1.25 MS/s single 

channel, 500kS/s two channel  
 16-bit resolution 
 AO 2.8 MS/s update rate 
 24 DIO lines,15 PFI, 2 CTR 

Prototyping Board 
 Updated connections 
 Detachable 
 User-defined Banana Plugs, 

BNC, D-Sub connectors 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

NI ELVIS II+ Hardware | Oscilloscope 

Oscilloscope 
 100MS/s Sampling Rate 
 50MHz Bandwidth(-

3dB) 
 8-bit resolution 
 ±20 V max. input range 
 AC/DC/GND coupling 
 20MHz Optional Noise 

Filter 
 BNC connection 
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NI ELVISmx Driver | Software Specifications 

• Ready-to-use instruments – Soft Front Panels 

• Customizable instruments 
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NI ELVISmx Driver | Software Specifications 

• NI LabVIEW Express VIs 

• NI DAQmx API 

• NI LabVIEW SignalExpress  
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DMM 
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Function Generator 
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Programable Power Supply 
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Bode Analyzer 
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Dynamic Signal Analyzer 
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Arbitrary Waveform Generator 
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Impedance Analyzer 
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Digital In/Out 
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2-Wire Current Voltage analyzer 
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3-Wire Current Voltage Analyzer 
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Controls and Mechatronics Telecommunications 

Embedded Design Digital Electronics 

Circuits and Measurements 

NI ELVIS Platform 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

• Xilinx Spartan 3E 

FPGA 

• Integrated 

Breadboard 

• Power Supply 

• ADC and DAC 

• LEDs 

• Push Button Encoder 

• 7 Segment Display 

• Switches & Buttons 

• USB Connection 

Digital Electronics FPGA  

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Digital Electronics FPGA  

Digital Circuit development 
platform based on the Xilinx 
Spartan 3E FPGA 
 

• I/O to teach basic to 
advance digital 
electronics concepts 

• JTAG-over-USB 
connectivity 

• 6 Pmod connectors 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

NI DE FPGA Board | Programming 

VHDL/Verilog NI LabVIEW 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Challenge:  Digital Electronics  VHDL  

Boolean Algebra Logic Gates 

Digital Logic  

Design 

DE FPGA  
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

QNET-011 Rotary 

Inverted Pendulum QNET-012 HVAC 

Trainer 

QNET-010 DC Motor 

Control Trainer 

NEW! QNET-013 VTOL 

1DOF Helicopter Plant 

NEW! QNET-014 Mechatronics 

Sensors 1 Board 

NI ELVIS | Controls & Mechatronics 

Plants 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

DATEx 

Exammple approach QPSK 

Quadrature Phase Shift Keying 

Start with Math and Theory 

 

QPSK = xp(t) * cos(w*t) + xq(t) * sin(w*t) 

  

where xp(t) and xq(t) are aternate elements of a digital 
sequence 
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DATEx 

• Represent it as a Block Diagram 
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DATEx 

• Build it using DATEx modules 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Teaching | Fiber Optics 

Step 1: Block diagram approach to optical 

signal filtering, splitting and combining 

Step 2: Connecting FOTEx Modules and 

NI ELVIS Instruments 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

SIGEx 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

SIGEx 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Emona FOTEx  ETT-203 

NI ELVIS | Telecommunications & Fiber 
Optics 

Emona  DATEx  ETT-202 

Teaching materials 

included 

Emona SIGEx  ETT-311 
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41 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Cypress PSoc NI ELVIS board 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Cypress PSoc NI ELVIS board 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Example of daughterboard PSoC 3 kit 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

In case it’s still not enough…. 

DYI boards  for Elvis 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Online Resources 

NI ELVIS II Guided Tour Courseware Download 

Resource Kits 

Webcast 
Textbook 

Resources 
Case Studies & White 

Papers 

ni.com/nielvi
s 

13. 4. 2012 

46 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Integrated DMM 
V, I, Ω, Diode 

USB Bus Powered 

3.5mm 
Audio In/Out 

8 Digital In/Out 

±15 V and 5V 
Power Supply 

Analog In/Out 
2 ch, 200ks/s 

NI myDAQ Features 

Plug & Play Instruments 

DMM * Oscilloscope * Func Gen 

Bode * DSA * ARB * Digital I/O 

 

 
Computer Interface 
LabVIEW using 
NI DAQmx 

1 Counter 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

MyDAQ Prototyping Board 

 

13. 4. 2012 
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My DAQ connectivity board 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

MyDAQ Agroentineering Farm plant 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

MyDAQ Dynamometer plant 
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MyDAQ Smartgrid plant 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Endless Possibilities… 

Custom PCBs  & Signal Conditioning 

Low Cost Mini-System Experiments 

(Custom PCB design templates available in NI Multisim.) 

Extend learning with custom modules 

• Custom signal 

conditioning 

• Custom control plants 

• Experiment kits 

• Student design 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Online Resources 

Webcasts Labs & Curricula 

Textbook 

Resources 
Case Studies & White 

Papers 

ni.com/academic 
ni.com/nielvis 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

NI Electronics Education Platform 

Electronics Education Platform 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Multisim & Other SW Tools 
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Agenda 

A. Introduction to the NI Multisim 

B. Schematic Capture 

C. Simulation 

D. Prototyping 

E. Measurement and Comparison 

F. Multisim Addons 

G. other SW tools for co-simulation 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

NI Multisim 12 

NI Multisim 
 

Unified environment  for  
teaching circuit  theory and 
design through capture  and 
simulation 

• SPICE-based simulation 

• Interactive mixed-mode simulation 

• NI ELVIS instruments inside Multisim 

• 20 SPICE analyses 

• 22 measurement instruments 

• MCU simulation support 

• Power and Machine components (motors..) 

• PLD design tools 

• Multisim and LabView Co-Simulation 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Theory and Measurement 

Compare simulated data and measured signal on the same instrument  

Access NI ELVIS 

hardware With one 

click switch between 

simulated signals and 

acquiring signals from 

your NI ELVIS II 

hardware 

NI ELVIS II Instruments Compare simulated 

Multisim data with measured signals from NI ELVIS 

II within Multisim 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

What is Multisim? 

– General purpose EDA tool 

– Schematic Capture 

– Simulation 

– Analyses 

– Integrated  

 Environment 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Benefits of Integrated Capture & 
Simulation 

– Preparation for simulation is as simple as drawing a 
circuit 

– Interactive Simulation 

– Animated Parts 

– Virtual Instruments 

– Analyses and Graphs 

 

Effective use of your time! 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

The Design Process 

Where does Multisim fit in the design flow? 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

The Multisim GUI 

 

Organized menus 

Quick access toolbars 

Design Toolbox 

Spreadsheet View 

Resizable Workspace 

Design 

Toolbox 
Menus Toolbars Title Bar 

Workspace 

Area 

Spreadsheet 

View 

Instruments 

Toolbar 

13. 4. 2012 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Global Preferences 

• Options»Global Preferences 

• Vary from computer to computer 

• Stored in the User configuration file 

– Change config file and database paths 

– Save settings (security copy, backup, simulation data) 

– Component Placement mode, symbol standard 

– Rectangle behavior, mouse wheel behavior, bus wiring 

– Message prompts and general simulation settings 

 

13. 4. 2012 

64 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Global Preferences         Simulation tab 

– Netlist errors action 

– Default background 

– Phase shift direction 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Global Preferences         General tab 

– Selection rectangle 

– Mouse-wheel behavior 

– Wiring mode 

– Localization 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Sheet Properties 

• Options»Sheet Properties 

• Saved with the design file, if opened in another 
computer same settings will be used. 

– Color scheme and display properties 

– Sheet size 

– Wire and bus options 

– Font properties 

– PCB settings 

– Visibility status for annotation layers 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Sheet Properties – Circuits tab 

– Component display properties 

– Net names display properties 

– Bus entry display properties 

– Color scheme 

Tip: Experiment with changing the display 

properties of components, keep a balance 

between good visibility and optimum 

information display. 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Toolbars and Menus 

– Organized based in functionality 

– All toolbar functions found in menus 

– Right-click toolbar area and toggle toolbars 

– Customizable (functions, location) 

– ToolTips 

– Lock toolbars 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Workspace Area 

– Schematic area 

– Multiple tabs 

– Zoom in and out 
with the mouse 
wheel (default) 

– Use View menu 
to show/hide 
Grid and Page 
Border 

Design 

Workspace 

Area 

Multiple 

Design Tabs 

Page 

Borders 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Schematic Capture 

– Multisim offers click-and-place 
capture mode 

– Integrated with simulation 

 

 Three step process: 

Select Place Wire 

Component Database 

In-Use List 

Copy 

Replace 

Rotate 

Flip 

Multi-section 

Automatic 

Touching-pins 

Dropping 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Components 

– Symbolic representation of actual parts 

– All components have a symbol 

– Many components have a SPICE model and footprint 

Capture Area Simulation Engine PCB Layout 

Symbol SPICE Model Footprint 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Components – Properties 

• Double-click component to: 

– Change Label, RefDes 

– Display properties 

– Value 

– Faults  

– Check Pin assignment 

– Set Variant information 

– Modify User Field information 

In the Value tab, click 

Edit Component in DB 

to customize the 

component. 

 (not for RLC components) 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Components – Edit Component in DB 
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Components – Virtual, Real, Layout-only 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Component Database 

• Tools»Database»Database Manager 

• Three levels: 

 

 

 

• Parts bin up to 17,500 parts (Power Pro edition) 

• Master database cannot be edited 

• Database utilities let you merge other user’s 
database, or convert a database from a previous 
version 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Component Database 

• Corporate database 

– Share components with colleagues 

– Located in local disk or network drive 

• User database 

– Store your own custom components 

• If you modify a Master database component, save it 
into the Corporate or the User database. 

Caution: Always backup your Corporate 

or User database. 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Component Browser 

• Place»Component 

• Most common tool to place components. 

• You can select: 

• Database 

• Component 

• Model 

• Footprint 

• Search for components 
Tip: Right-click anywhere in the 

workspace and select Place Component 

to access the Component Browser. 
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1 

2 

3 

4 5 

6 

To place a part, 
select: 
1. Database 
2. Group 
3. Family 
4. Part 
5. Model 
6. Footprint 

You can also: 

•Search 

•Obtain datasheet 

•Print a detail report 

•View model 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Placing a Component 

– After selecting a component, a ghost image is 
attached to the mouse pointer 

– Click to place 

– Next RefDes is assigned 
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I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Placing Multi-section Components 

Select any section for 
a new IC 

Select C or D to place 
unused sections of 
U1 

U1, section A and B are already 
placed, therefore they are not 
selectable 
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Component Toolbar and the In-Use List 

• Access Master database Groups from the 
Components toolbar. 

 

• Use the In-Use List to place another instance of an 
already placed component. 
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Rotating a Component 

– If already placed • While placing 
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Component Search 

• From the Component Browser, click Search 

• Use * as a wildcard 
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Component Search – Results 

Number of 

components 

matching search 

criteria 

List of 

components 

matching search 

criteria 

Details of 

component 

selected 

OK will take you 

to the exact 

database 

location 
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Nets 

– Wires are the graphical representation of nets 

– Modeless (no placing vs. wiring mode) 

– Mid-air wiring is allowed 

– Real-time netlist is updated behind the scenes 

– Easy to change wire connections once placed 
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Nets 

• Multiple wires can make one net or node 
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Junction Dots 

• Junction dots represent a wire connection 

13. 4. 2012 

88 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Methods for Wiring – Automatic 

13. 4. 2012 

89 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Methods for Wiring – Touching Pins 
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Methods for Wiring – Dropping  
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Changing Wire Properties 

– Right-click the wire to access the run-time menu 

– Change colors, net name font and properties 
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Moving Wires 
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Re-wiring a Net 
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Virtual Wiring 

– Useful in large designs 

– Avoids unnecessary wires crossing the schematic 

– Give a net a name that already exists to create the 
virtual connection 

– Use Global or On-page connectors 

  Global  connectors are visible to the whole design 

  On-page connectors are visible to the sheet 

  On-page connectors may connect to Global 
connectors 
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Virtual Wiring 

Place/connectors/.. 
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Virtual Wiring 

My Design 

Page X Page Y 
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Analyses in Multisim 

– Multisim provides analyses for examining circuit 
behavior 

– Analyses require a circuit ready for simulation 

– Custom expression can be added 

– Grapher View helps to take precise measurements 
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Analyses in Multisim 

DC Operating Point Distortion Analysis Transfer Function 

AC Analysis DC Sweep Worst Case 

Single Frequency AC Analysis Sensitivity Monte Carlo 

Transient Analysis Parameter Sweep Trace Width Analysis 

Fourier Analysis Temperature Sweep Batched Analysis 

Noise Analysis Pole Zero User Defined Analysis 

• The following analyses are available: 
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Using Analyses 

• Simulate»Analyses»… 

• Four step process: 

 

Tip: Click Help on any window to 

access analysis-specific information. 

Select Configure Simulate Review 

Select analysis Enter expressions 

 

Select output 

variables 

 

Configure analysis 

parameters and 

options 

Click Simulate Grapher View 
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Selecting Output Variables 

• Choose output variables from the list 

• Voltages and currents per node (net) are listed as well 
as current and power per component 

• Add model or device parameters 

• Resistance 

• Capacitance, and so on 

– Add expressions 
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Adding Custom Expressions 

– Double-click variable or operand to add it to the 
expression 

– Type expression manually 

– Use built-in functions to help create custom analysis 
outputs 
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The Grapher 

• Displays simulation 
results from: 
• Virtual Instruments 

• Analyses 

• View, adjust, save, print 
export data 

• Precise cursor 
measurements 

• Overlay different results 
to compare 

• Make annotations and 
place data labels 
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The Grapher – Cursors 

– Take precise measurements with the cursors 

– Right-click cursor to access functions for positioning 
and data labels 
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The Grapher – Overlay Traces 

• Compare different graphs 
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The Grapher – Properties 

– Set custom properties for pages and graphs 

– Modify the appearance of traces and axes 
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The Grapher – Mixed Displays 

• Some analyses output table data instead of plot data 
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The Postprocessor 

• Use the Postprocessor to: 
– Mathematically manipulate analyses results 

– Plot results in a graph or chart 

– Customize results output 

• At least one analysis run is required 

 

• Simulate»Postprocessor 

• Examples:  
– Add voltages 

– Calculate power from voltage and current 

13. 4. 2012 

108 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Using the Postprocessor 

Run Analysis 

Add Expression (s) 

Add Page (s) 

Add Graph (s) Set Grapher 

properties 

Attach Expression  (s) 

Calculate 

Review Results 

Customize Output 

Grapher View 

Click Calculate 

Add expressions 

to graphs 

At least one 

analysis is 

required 

Create re-usable 

expressions 

Add Grapher 

pages 

Create graphs or 

charts for each 

page 
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Using the Postprocessor – Expression Tab 

– Select from 
available results 

– Select from 
available 
variables 

– Build 
expressions 
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Using the Postprocessor – Graph Tab 

– Add Pages 

– Add Graphs or 
Charts to Pages 

– Assign 
Expressions 

– Click Calculate 
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Viewing Results from the Postprocessor 

– The Grapher displays Postprocessor results like any 
other instrument or analysis 

– Use the cursors to make precise measurements 

– Set the graph properties to fit your results 

– Save, print or export results to external applications 
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Design Blocks 

• Build a library of commonly used circuits 

• Reuse circuit models 

• Changes propagate 

• Cleaner, modularized architecture 

• Use the Design Toolbox to browse through the 
hierarchy 

• Three options: 

• Hierarchical Blocks 

• Subcircuits 

• Multi-page 
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Design Blocks – Before 
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Design Blocks – After 
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Design Blocks – Connectors 

– Interconnect circuits with HB or SC connectors 

– Rename connectors 

– Connector name = netnames 

13. 4. 2012 

116 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Nested Circuits 

– Hierarchy tree organization 

– Use Design Toolbox 
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Creating Design Blocks 

• Multiple options to create or use blocks 

– Place»New Subcircuit (or Hierarchical Block) 

– Place»Hierarchical Block from File 

– Place»Replace by Subcircuit (or Hierarchical Block) 
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Multi-page Design 

– For flat design 

– Split in pages 
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Multi-page Design 

– Same hierarchy level as top-level page 

 

 

 

 

 

– Workspace tabs per page (reorder in Design Toolbox) 
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Multi-page Design 

– Interconnect pages with Off-page connectors. 

– Alternatively, you could use Global with On-page 
connectors. 
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Modular Design Summary – Pros & Cons 

Hierarchical 

Blocks (HB) 

Subcircuits 

(SC) 

Multi-page 

Pros Cons 

• Good for flat designs 

• Every page saved in the same circuit file 

• Organized horizontal view of design 

• Not for reusing blocks in a later project 

• Not recommended for non-flat designs 

• File size is bigger 

• Updating a section requires the complete 

circuit to be open 

•Every page saved in the same circuit 
file 

•Symbol is editable 
•Easy to visualize functional blocks 

 

• Not for reusing blocks in a later project 

• File size is bigger 

• Updating a section requires the complete 

circuit to be open 

• Best option to reuse circuit blocks 

• Symbol is editable 

• Smaller file size 

• Easy to visualize functional blocks 

• Updating the HB updates all designs where 

it is used 

• HBs need to accompany the main design 

file every time you move it 

R
eco

m
m

en
d

ed
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Buses 

• Buses simplify wiring 

• Carry multiple nets 

• Used within: 

• a page 

• across pages 

• across design blocks 
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Bus Wiring Modes 

– Set mode in Options»Sheet Properties»Circuit tab 

– Bus wiring modes:  

• no labels, 

• net names,  

• busline names 
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Bus Vector Connect 
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Bus Entry Connect 
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Bus Manipulation 

13. 4. 2012 

127 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Tools Available to Customize Components 

– Component Properties  – edit components 

– Corporate/User DB  – save custom components 

– The Component Wizard  – create new components 

– Model Makers   – create new SPICE 
models 

– The Symbol Editor   – create new symbols 

– Database Manager  – manage custom components 
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Component Properties 

– Double-click a component to access the Properties window 

– Click Edit component in DB to edit the component 

– Use the tabs to modify component information or 
configuration 
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The Component Wizard 

• Step by step assistant guides you in the new 
component creation 

• Store the new component in the User or Corporate 
database 

• Number of steps depend on intended use of 
component: 

• Simulation and Layout   (model and footprint) 

• Simulation only   (model) 

• Layout only   (footprint) 

• Tools»Component Wizard 
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The Component Wizard       Step 1 

• Step 1: Enter Component Information  

• Name, author, function 

• Component type: 

– Analog for most  

 components 

– Digital if you have XSPICE 

• Select use of component 
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The Component Wizard       Step 2 

• Step 2: Enter Footprint 
Information 

– Select footprint from 
database 

– Use custom footprints 
from       Ultiboard 

– Define number of 
sections 

– Define number of pins 
per section 
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The Component Wizard       Step 3 

• Step 3: Enter Symbol 
Information 

– Copy symbol from 
database components 

– Copy symbol to DIN 

– Create symbol per  

 section 

– Click Edit to launch  

Symbol Editor 
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The Symbol Editor 

• Specialized graphics editor 

• Create / modify symbols 

• Save symbol files 

• Also access from: 

• Tools»Symbol Editor 
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The Symbol Editor 

• Define pin 
shapes 

 
• Define pin names and properties using the 

Spreadsheet View 
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The Symbol Editor – Repeated Pins 

• Method 1: One 
single pin 
representing 
multiple pins 
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The Symbol Editor – Repeated Pins 

• Method 2: One pin with an appended suffix 
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The Symbol Editor – One Shared Pin 

• If a component shares one single pin across multiple sections, such as a 
GND connection: 

– Create a duplicate pin per section 

– In Step 5 assign the same footprint pin to every instance of that pin in 
each symbol 

• The other option  

is to add that pin as  

a hidden pin, which is  

part of the model  

and/or footprint but  

does not show in the  

schematic. 
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The Component Wizard       Step 4 

• Step 4: Set Pin 
Parameters 

• Set sections: 
– A, COM, Power, … 

• Set pin types for ERC 

• Set ERC status 

• Add hidden pins (not in 
the symbol but needed 
for model and/or 
footprint 
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The Component Wizard       Step 5 

• Step 5: Set Mapping Information Between Symbol 
and Layout Footprint 

– Multiple footprint pins  

can be mapped to a single  

symbol                                                          pin 

– Set Pin and Gate Swap                                                         
Group  Information 

Caution: The accuracy of this mapping will 

impact the PCB layout design. 
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The Component Wizard       Step 6 

• Step 6: Select Simulation Model 

– Define model per section 

– Copy model from database 

– Load model from file 

– Use the Model Maker 

Note: The quality and sophistication of a SPICE model 

directly impacts the ability to simulate that component 

correctly and accurately. 
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Model Maker 

– Automatically generate 
simulation models 

– Use datasheet 
parameters 

– Preset values provided 

Caution: Model accuracy can only be guaranteed by the component manufacturer. 
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The Component Wizard       Step 7 

• Step 7: Set Mapping 
Information Between 
Symbol and Simulation 
Model 

– Model nodes are in order 
of appearance 

– Set model node per pin 

– Set model nodes per 
section 

Caution: The accuracy of this mapping will 

impact the simulation results. 
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The Component Wizard       Step 8 

• Step 8: Save Component to Database 

– Select User or Corporate Database 

– Select Group and                                                                          
Family 

– Modify Family icon                                                                      
from the Database                                                              
Manager 
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Database Manager 

– Manage Master, 
Corporate and 
User database 

– Edit, copy, delete 
and move parts 

– Import and 
export 
components 

– Filter allows you 
to browse quickly 

– Create and 
modify new 
Families 

– Set User Fields 
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Converting and Merging Databases 

• Tools»Database»Convert Database 
– Convert an older version (2001, 7, 8, 9 or 10) database to 

11 
 
 
 
 
 
 
 

• Tools»Database»Merge Database 
– Merge an existing version 11 database 
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Importing and Exporting Components 
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MCU Co-simulation 

– Adds co-simulation capabilities  

• C or assembly with SPICE components 

– Simulate like any other circuit 
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MCU Co-simulation 

• Supports: 

– 8051, 8052 

– PIC16F84, PIC16F84A 

• Includes peripherals like                                                          
ROM and RAM 

 

• Advanced peripherals: 

– Keypads 

– LCD Displays 

– VTERM terminal 
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MCU Workspace 

– Dedicated hierarchy in the Design Toolbox 

– Organized in projects 

13. 4. 2012 

151 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

Code Manager 

– Manage MCU files 

– Enter build settings for source code 

– Define compilers 

– Create new projects 

– Define external ROM (XROM) 

– Set special Link or library calls 

– MCU»<MCU name>»MCU Code Manager  
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Source Code Editor  

– Click source file in the Design Toolbox to open editor 

– Color coded text editor 

– Similar to other programming IDEs 
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Memory View 

– MCU»<MCU name>»Memory 
View  

– Pause simulation to view memory 
addresses in real-time 

– Click an address to change                                                                       
its value 

– Load or save EEPROM                                 
hex values 
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Debugging Features 

• Build Process messages in the Results tab of the 
Spreadsheet View 
 
 
 
 
 
 

• Debug View lets you follow and track a sequence of events 
– Breakpoints 
– Debug Stepping 
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Debugging Features – Breakpoints 

– Place breakpoints 
in   left margin 

– Simulation stops 
at breakpoint 

– Use stepping 
functions 

• Step Into 

• Step Over 
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Debugging Features – Disassembly 

• Debug View drop-down list lets you select 

– Source Code View 

– Disassembly View 
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MCU modul 

• Demo 
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PLD / FPGA modul 
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• Create new PLD Design in Multisim 
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• Select PLD Target 
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• Select PLD family 
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• Select I/Os 
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• Define the PLD..  
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3D Breadboard 

– Place components in 3D 
on a virtual breadboard 

– Practice wiring a 
breadboard based on a 
circuit diagram 

– Component symbols and 
wires turn green when 
placed correctly on 
breadboard 
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3D ELVIS Breadboard 

– File»New»NI ELVIS I Design  ... Or NI ELVIS II Design 

– Interact with NI ELVIS instruments 

– Place and verify diagram similar as the virtual breadboard 

13. 4. 2012 

168 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

“In theory, theory and practice are the same. 
In practice, they are not.” 

- “Yogi” Berra 

E. Measurement and Comparisons 
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Introduction to LabVIEW 
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LabVIEW Graphical Development System 

• Graphical Programming Environment 

• Compile code for multiple OS and devices 

• Useful in a broad range of applications 
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Virtual Instrumentation Applications 

• Design 
– Signal and Image Processing 
– Embedded System Programming 

• (PC, DSP, FPGA, Microcontroller) 

– Simulation and Prototyping 
– And more… 

• Control 
– Automatic Controls and Dynamic 

Systems 
– Mechatronics and Robotics 
– And more… 

• Measurements 
– Circuits and Electronics 
– Measurements and 

Instrumentation 
– And more… 

Graphical System Design 

Demo 
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LabVIEW Control Design 

• Easily create interactive control 
design and analysis VIs 

• Use both textual .m file and 
graphical approach 

• Model construction, conversion and 
reduction 

• Time and frequency response 

• Dynamic characteristics 

• Classical control design including 
analytical PID                 

• State-space control and estimation - 
LQR, LQG, Model Predictive Control, 
Kalman Filter.. 
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LabVIEW MathScript RT 

• Powerful textual programming for 
Control Design, Signal Processing, and 
Math  
– Hundreds of built-in functions 

– Reuse many of your m-file scripts created 
with The MathWorks, Inc.’s MATLAB® 
software and others 

– Partially based on original math from 
MATRIXx 

• A native LabVIEW solution 
– Interactive and programmatic interfaces 

– Does not require 3rd party software 

MATLAB® is a registered trademark of The MathWorks, Inc.  

13. 4. 2012 

174 



I N V E S T I C E  D O  R O Z V O J E  V Z D Ě L Á V Á N Í  

LabVIEW MathScript RT Demo 

• Graphical and textual programming 

• Interactive user-interface 
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Dynamic System Simulation & Control 

• Both signal flow and .m file  

 development 

• Single environment for: 
– Simulation of dynamic systems 

– Real-time implementation for rapid  

 control prototyping or  

 hardware-in-the-loop simulation 
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Standard Notation Reduces Learning Curve 

• LabVIEW Control Design & Simulation Module 

 

 

 

 

 

 

•  The Simulink® software environment 

Simulink® is a registered trademark of The MathWorks, Inc. 
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Simulink® conversion 

 Convert plant and controller models you create in 
the Simulink®  environment into LabVIEW Control 
Design & Simulation Module code   

 

 

Simulink® is a registered trademark of The MathWorks, Inc. 
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LabVIEW System Identification Toolkit 

• Data preprocessing 
– Down Sampling, Remove  

Trends, Split Signal, Filters 

• Parametric model estimation 
• Nonparametric model 

estimation 
• MIMO capability 
• Nonlinear model estimation 
• Grey box system identification 
• Closed-loop system 

identification 
• Model validation 
• System identification assistant 

Real-Time Windows 
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Solving ODE Example 
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NI Platform for Control 

 

 

 

 

 

Control Design & 

Simulation Module 
System ID Toolkit Statechart Module 

LabVIEW Real-Time LabVIEW FPGA 

cRIO, sbRIO PXI Desktops & SBC’s 

Targets 

DFD Toolkit 
Simulation Interface 

Toolkit 
NI Motion Control 

LabVIEW  Microprocessor 

32-bit mp 

LabVIEW Development Environment 
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Multisim Power Components 

• 92 new component models of power 
and electromechanical devices 

• Reconfigurable transformers 

• Power switches 

• Power controllers 

• Non-ideal RLCs 
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Electrical Power Measurement Suite 

• Measure power quality and 
energy features to IEC, EN, and 
IEEE standards 

• Harmonics (IEC 61000-4-7) 

• Flicker (IEC 61000-4-15) 

• Sag/sell/interruption with 
standard or custom levels (IEC 
61000-4-30) 

• Rapid voltage change with 
standard or custom levels (IEC 
61000-4-30) 

• Compatibility with the 
COMTRADE (IEEE 37.111) file 
format 
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Multisim-LabVIEW Co-simulation 

• Control Design and Simulation 
Module 
– External Modeling Interface (EMI) 

• Prototype features: 
– Lock-step synchronization 

– Step-size negotiation 

– Support for all continuous-time 
LabVIEW solvers 

– Multisim block configuration 

Demo 
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